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MAKING DOCUMENTS ADA ACCESSIBLE 

By: Danielle DavisRoe, Esq. 

WHAT DOES IT MEAN FOR A DOCUMENT TO BE ADA ACCESSIBLE?  
The Americans with Disabilities Act of 1990 (“ADA”)—together with the standards courts and regulators apply under 
it—sets expectations for creating documents that screen readers, keyboard-only users, and people with low vision 
can read and navigate. Screen readers are software applications that enable people who are blind or have low vision 
to use computers; they typically deliver content through synthesized speech or refreshable braille and are navigated 
by keyboard rather than mouse. Other readers rely on screen magnifiers, voice control, switch devices, o r simply on 
documents that do not fight their cognitive load. No document is “100% accessible” for every reader because 
assistive technologies vary. However, there are concrete things you can do to make your work usable for the 
overwhelming majority of readers—and to keep your firm on the right side of an increasingly active legal landscape. 
While these recommendations cover the issues most likely to trip you up, they are not exhaustive.  

RECENT DEVELOPMENTS  
Three developments deserve top billing: 

First, WCAG 2.2 became the W3C’s recommended standard in October 2023 (with an editorial update in December 
2024), adding nine new success criteria that address cognitive load, mobile interaction, and authentication  

Second, in April 2024 the U.S. Department of Justice issued a final rule under ADA Title II requiring state and local 
government websites and mobile apps to meet WCAG 2.1 Level AA; in April 2026, DOJ extended the phased 
compliance deadlines to April 26, 2027 for entities serving 50,000 or more residents and April 26, 2028 for smaller 
entities. 

Third, federal ADA Title III website-accessibility filings continued their upward march—roughly 8,800 federal cases 
in 2024 and over 3,000 in the website subset for 2025, a 27% year-over-year jump concentrated in New York and 
Florida. The Title II rule does not bind private law firms directly, but courts hearing Title III cases increasingly t reat 
WCAG 2.1 AA—and in some jurisdictions WCAG 2.2—as the working benchmark.  

If your firm publishes content the public can encounter—your website, your client portal, the brochures and intake 
forms you send by email, assume it will eventually be read by someone using assistive technology and plan 
accordingly. 

IT ALL STARTS WITH YOUR WORD PROCESSOR  
It doesn’t matter whether you share the document as a Word file, WordPerfect file, Pages file, Google Doc, PDF, or 
another file type; setting your documents up for accessibility success starts in the word processor. The common 
issues are heading structure, alternative text for visuals, hyperlinks, color, and tables. Microsoft, Google, and Adobe 
have all leaned heavily into AI-driven accessibility tooling recently, but the underlying habits are unchanged.  

HEADING STRUCTURE  
Screen readers rely on the heading structure of the document to navigate quickly. The heading styles in your word 
processor control that structure. Use heading styles in numerical order: the top level of your outline must be Heading 
1, the second level Heading 2, and so on. Do not pick a heading style because of how it looks; pick it because of 
where it sits in your outline, and adjust the style’s appearance separately if you want a differ ent look. 
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Beyond accessibility, using styles to control formatting has several benefits for you as the document author: fewer 
formatting frustrations, consistent application of headers and body text, easy creation of tables of contents that 
update with one click, swift document navigation, and proper style-based PDF bookmarks when you export.  

ALTERNATIVE TEXT FOR VISUALS  
Visuals—pictures, SmartArt graphics, shapes, groups, charts, embedded objects, ink annotations, screenshots, and 
videos—create problems for screen readers. The screen reader cannot read text inside an image, and it cannot 
describe an image unless you tell it what is there. Use alternative text to describe the visual and include any 
pertinent text it contains.  

WORD AND POWERPOINT NOW OFFER AI-GENERATED ALT TEXT 
On a Copilot+ PC, when you insert an image, an AI-generated alt-text suggestion appears at the bottom of the image. 
You can accept it or click Edit to refine it in the Alt Text pane. On other devices, you can right-click an image and 
choose “Generate alt text for me.” Treat the AI’s output as a first draft, not a final answer: it is good at object 
recognition and weaker at context, intent, and proper nouns. If the image is a courtroom diagram, the AI will tell 
you it is “a black-and-white floor plan.” You still need to tell the reader it is a diagram of where each witness sat at 
the Smith deposition.  

Decorative images that carry no informational content should be marked as decorative in the Alt Text pane. That 
tells screen readers to skip them rather than announcing “image” with nothing useful to follow.  

HYPERLINKS  
People using screen readers frequently prompt the screen reader to scan for a list of hyperlinks. That list is pulled 
out of context, so a link reading “click here” or “more information” tells the reader nothing about where it goes. 
Add the hyperlink to a description of the linked location—“Read the Iowa Supreme Court’s opinion in Smith v. Jones” 
rather than “Click here for the opinion.”  

COLORS 
If color is used to convey meaning, those who are color blind will miss it. You may still use color to give meaning at 
a glance for other readers, but pair it with a second cue—bold, italics, an icon, a label, or a pattern—so color-blind 
readers and anyone reading in grayscale (printed or photocopied) get the same information.  

Contrast matters as well. WCAG sets the floor at a 4.5:1 contrast ratio for normal body text against its background, 
and 3:1 for large text (roughly 18-point regular or 14-point bold and larger). WebAIM’s free Contrast Checker is the 
fastest way to confirm any given color pair passes.  

TABLES 
Screen readers expect a simple, predictable table structure. They track location by counting cells, so nested tables, 
merged cells, and split cells confuse them. Blank rows and columns can also tell the screen reader “the table is over” 
and cause it to miss content below. Where you would normally use spacing rows or columns for visual breathing 
room, use cell padding, paragraph spacing, or border styles instead.  

Mark the first row of every data table as a header row. In Word, right-click the first row, choose Table Properties, 
and on the Row tab check “Repeat as header row at the top of each page.” That single setting fixes two problems at 
once: it makes long tables more usable for sighted readers and tags the row as a header when the document is 
exported to PDF. 

PDF 
Ensuring a PDF is accessible starts in the word processor and ends with how you create and finalize the PDF. The 
common issues are file properties, security, optical character recognition, color, tagging, hyperlinks, alternative text 
for visuals, tables, and forms. 
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A Note on Standards 

In March 2024, the PDF Association published ISO 14289-2 (PDF/UA-2), the “gold standard” for accessibility in PDF 
2.0. PDF/UA-2 does not replace PDF/UA-1; it adds richer requirements for tagging, annotations, and structure 
attributes for files saved in PDF 2.0. You do not need to memorize the standard to produce a good PDF, but if a court, 
agency, or client asks whether your document is PDF/UA compliant, that is what they mean.  

FILE PROPERTIES  
We typically want to scrub metadata from documents before sharing them outside our organizations, but some 
metadata is genuinely useful for screen readers, which rely on the title, author, subject, keywords, and language 
fields. Scrub the metadata you do not want to disclose (revision history, prior-editor identities, internal comments) 
and complete the fields screen readers use. The title should be the document’s actual title. The author should 
typically be the name of your firm or organization, not the staffer who happened to type it. The subject can repeat 
the title or provide additional information. Keywords are useful for search. The language field must be set to the 
language of the document’s text; without it, screen readers may use the wrong pronunciation engine and turn your 
brief into gibberish. 

SECURITY 
When locking down a PDF, leave the accessibility features enabled. Every major PDF tool—Adobe Acrobat Pro, Foxit, 
Nitro, Kofax Power PDF—has a checkbox that allows text access for screen readers even when other rights are 
restricted. Confirm that checkbox before you save.  

OPTICAL CHARACTER RECOGNITION  
PDFs created directly from a word processor are text-searchable by default. PDFs created from a scanner are not; 
the scanner produces an image of each page, and a screen reader cannot read an image. Optical character 
recognition (“OCR”) scans the image for characters and adds a layer of selectable, searchable text behind the image. 
Without OCR, a screen reader has nothing to work with. 

OCR has improved substantially in recent versions of Acrobat, particularly for documents with handwriting, faint 
text, or mixed languages. Run OCR on every scanned PDF you intend to share, and spot -check the results. OCR is 
reliable, not infallible, and a misread name or citation in a brief is its own problem.  

COLOR 
As in a word processor document, if color is used to convey meaning in a PDF, color-blind readers will miss it, and 
insufficient contrast makes text hard to read for anyone with low vision. The 4.5:1 contrast rule applies here too.  

TAGGING 
Screen readers use tags to understand the structure of a PDF. Tags denote headings, body text, lists, images, tables, 
forms, and media. Tags can be inserted automatically when you create the PDF, or added afterward in your PDF 
software. When creating a PDF from Microsoft Word, use File > Export > Create PDF/XPS, click Options, and under 
“Include non-printing information” check “Document structure tags for accessibility.” For Office files saved on recent 
builds, the tagging quality is meaningfully better than it was three years ago—nested tags, alt text, and hyperlinks 
now translate more faithfully into PDF, and links are independently tagged for cleaner navigation. Tagging still 
requires that you actually use styles in the source document; the export feature cannot guess at structur e you never 
gave it. 

A NOTE ON ADOBE ACROBAT PRO  
For PDFs that arrive on your desk without tags, Adobe Acrobat Pro now offers cloud -based AI auto-tagging. Turn it 
on in Edit > Preferences > Accessibility > Enable cloud-based auto-tagging for accessibility, then open the untagged 
PDF and choose Autotag Document in the Accessibility menu. The AI version is materially better than the older local 
auto-tagger at recognizing heading levels and at detecting lists and tables that span multiple pages. Like AI alt text, 
treat the output as a first draft and verify in the Tags pane. 
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HYPERLINKS  
As with word processor documents, hyperlink text needs to make sense out of context. “Click here” is a problem no 
matter what file format it lives in. Use descriptive link text.  

ALTERNATIVE TEXT FOR VISUALS  
As with word processor documents, every meaningful image, chart, or embedded visual in a PDF needs alt text. The 
screen reader cannot read text inside an image, and it cannot describe a chart unless you do.  

TABLES 
Tables in PDFs follow the same rules as tables in a word processor: simple structure, no nested or merged cells, no 
blank rows or columns, and a defined header row. If your data does not require column headers, you probably do 
not need a table at all; use tabs or indents to align content instead.  

In Microsoft Word, right-click the first row of the table, choose Table Properties, and on the Row tab check “Repeat 
as header row at the top of each page.” When you export to PDF with tags, the first row will automatically be tagged 
as the header row. 

FORMS 
Fillable forms need instructive text at the start of the form. Fields must have a logical reading and navigation order, 
which means setting the tab order explicitly rather than trusting the field placement. Every field needs a visible label 
(typically to the left of or above the field), a title, and a description in the field’s properties. Checkboxes and radio 
buttons need to be grouped with their alternative choices so the screen reader announces them together. Avoid 
multiple-select dropdowns—they are difficult to operate with assistive technology and difficult to label clearly.  

REVIEW YOUR DOCUMENTS FOR ACCESSIBILITY  
When reviewing your documents for accessibility, start with the built-in accessibility checker in your word processor 
or PDF software. Checkers will not find every issue—they are particularly weak on questions of meaning, like 
whether a hyperlink’s text is descriptive or whether color is the only cue for an important distinction —but they catch 
the mechanical errors quickly, and the better ones offer one-click fixes. After the checker, do a manual pass.  

MICROSOFT WORD 
Word’s accessibility checker lives on the Review ribbon under Check Accessibility  (Mac or Windows), or under File > 
Info > Check for Issues > Check Accessibility (Windows) or Tools > Check Accessibility (Mac). Newer builds also 
surface an Accessibility Assistant side pane that runs continuously as you draft, flagging issues in real time rather 
than waiting for a one-shot review. The checker looks for missing alternative text, insufficient color contrast, and 
some table issues. It will not catch illogical heading order, vague hyperlink text, color used as the only conveyance 
of information, or blank rows and columns. Those still need manual review.  

HEADING STYLES  
Open the navigation pane (View ribbon > Navigation Pane). Paragraphs styled with heading styles appear nested 
under each other. Skim for anything out of order, like a Heading 3 directly under a Heading 1, a Heading 1 that should 
be Heading 2, or a “heading” that is really just bold body text.  

HYPERLINKS  
Click the dropdown next to Find on the Home ribbon and choose Go To (Windows), or Edit > Find > Go To (Mac). 
Under “Go to what,” choose Field; under “Enter field name,” type Hyperlink. Use Next to jump from link to link and 
confirm each one reads sensibly out of context.  

COLOR 
Skim for any text that is not black (or your standard body color) and ask whether the color is doing work that 
grayscale would not. 
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BLANK ROWS AND COLUMNS IN TABLES  
Use Go To again, this time set to Table, to step through every table and check for empty rows or columns.  

ADOBE ACROBAT PRO  
The accessibility tools live in the same place: search the Tools pane for “accessibility,” open the Accessibility pane, 
and click Accessibility Check to run the checker. It looks for errors with permissions, file properties, OCR, tags, logical 
reading order, language, title, bookmarks, color contrast, form-field descriptions, and alternate text. The checker 
catches more than Word’s, but it still will not reliably flag merged or split cells, vague hyperlink text, or color used 
as the sole conveyance of information. 

Acrobat Pro also produces an Accessibility Report detailing what it checked and whether your file passed each check. 
Use the report to triage; use the Tags pane and the Reading Order tool to actually fix what the report flags.  

If you are working with a PDF created by someone else and the tags are a mess, run the cloud -based auto-tag 
(described above) before you start fixing things by hand. Auto-tagging plus a thorough manual review is meaningfully 
faster than starting from a blank Tags tree. 

A NOTE ABOUT FIRM WEBSITES  
The same principles apply to your firm’s website, with higher stakes. Title III ADA website -accessibility lawsuits hit 
roughly 8,800 federal filings in 2024 and continued climbing in 2025, with plaintiffs frequently alleging that screen 
readers cannot navigate firms’ websites. Courts in those cases increasingly look to WCAG 2.1 Level AA , and, in some 
jurisdictions, WCAG 2.2,  as the working standard, even though the ADA itself does not name a technical specification 
for private businesses. 

Two practical points. First, accessibility overlay plugins—the floating widgets that promise one-click WCAG 
compliance—do not deliver what they advertise. The Lawyerist Podcast’s interview with Joe Hodge of the American 
Printing House for the Blind covers why these tools often make accessibility worse rather than better, and a 2024 
settlement involving a major overlay vendor underscored that overlays are not a substitute for actually building an 
accessible site. Second, if you do any work for clients in the European, note that the European Accessibility Act took 
effect on June 28, 2025. It binds most businesses operating in the EU (the carve -out is for firms with fewer than ten 
employees), uses EN 301 549 and WCAG 2.1 as its presumptive technical standards, and author izes penalties of up 
to €100,000 or 4% of annual revenue.  

Good accessibility practices benefit every reader, sighted users included. The same heading structure that makes 
your brief readable to a screen reader makes it skimmable to a busy judge. The alt text that helps a blind client 
makes your firm’s website show up better in search. Treat accessibility as professional baseline work, not a separate 
compliance project, and the cost-benefit math will pencil out. 

https://www.lawyerist.com/
https://legaltalknetwork.com/podcasts/lawyerist-podcast/
https://legaltalknetwork.com/podcasts/lawyerist-podcast/2023/06/448-the-benefits-of-accessible-systems-and-practices-with-joe-hodge/
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